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INTRODUCTION

SAP projects are used to define, document and implement company solutions to
given problems according to business requirements and SAP capabilities. 

SAP provides many tools for creating projects, however, business requirements
come from businesses and are IT independent. 

Business requirements are defined and formalized in modeling applications such as
MEGA Process. 

SAP Solution Manager helps implement and manage complex system landscapes.
In general, systems are distributed across different geographic locations, and
business processes cover more than one system. With such complex scenarios, IT
success depends on the integration of technical and business requirements. SAP
Solution Manager provides SAP customers with an efficient means of handling both
the technical and business process sides of solution implementation.

In order to quickly implement their business strategies and orientations, companies
must be able to quickly transfer their processes and new business concepts to the
SAP world. It is therefore important to align the business requirements as seen in
SAP with what has been designed in HOPEX Business Process Analysis.

This is where HOPEX SAP Blueprint comes in. Its purpose is to design and
document how SAP meets the business requirements as defined in HOPEX
Business Process Analysis. It is used to exchange information relating to
processes between HOPEX Business Process Analysis and SAP Solution
Manager. 

The HOPEX SAP Blueprint interface is used to align SAP process models with
business process models, thus providing organizations with the means for taking the
business view into account, improving implementation choices and reducing SAP
deployment and migration costs.

 "Conventions Used", page 2
 "Presentation of This Guide", page 3
 "Presentation of HOPEX SAP Blueprint", page 4
 "Presentation of SAP Solution Manager", page 6
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CONVENTIONS USED

 Remark on the preceding points.

 Definition of terms used in this guide.

 A tip that may simplify things.

 Things you must not do.

Commands are presented in this way: File > Open.

The names of MEGA products and technical modules are presented in this way:
HOPEX.

Very important remark to avoid errors during an operation.
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PRESENTATION OF THIS GUIDE

The following points are covered here:
 "Exchanging Data with SAP", page 11: explains how to exchange objects between 

HOPEX SAP Blueprint and SAP Solution Manager.
 "Designing for SAP Projects", page 21: explains how to:

• access SolMan data in HOPEX
• manage SolMan objects
• create mapping between SolMan objects and business objects
• initialize a SolMan project from business objects
• populate a BPMN diagram from a SolMan structure
• exchange documents between HOPEX and SAP Solution Manager
• manage implementation, maintenance, and template projects

 "Documentation in HOPEX SAP Blueprint", page 57: explains documentation 
generation in HOPEX, including Web sites, reports and MS Word reports.

 "HOPEX SAP Blueprint Glossary", page 77: definition of the main terms used in 
this guide.

 The present document does not describe how to install the 
components necessary for imports/exports into/from SAP Solution 
Manager. Refer to the "MEGA SolMan installation guide" available with 
the HOPEX SAP Blueprint portfolio.
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PRESENTATION OF HOPEX SAP BLUEPRINT

With HOPEX SAP Blueprint you can:
• Manage SAP projects

HOPEX SAP Blueprint provides the metamodel structure necessary for
hosting SAP Solution Manager Blueprint artifacts and for connecting them
to the business view. 
It manages the different lifecycle statuses of an SAP project. It
recognizes, when synchronizing an SAP project, if the project originates
from the evolution of the project lifecycle.

• Exchange data with SAP Solution Manager
HOPEX SAP Blueprint provides tools for importing and exporting data
into/from SAP Solution Manager.

In order to exchange SAP Solution Manager project definitions with HOPEX, the
HOPEX SAP Blueprint interface relies on:

• A tool that exports/imports projects from/into SAP Solution Manager.
• A metamodel in HOPEX, called the SolMan metamodel that is used to 

describe SolMan projects. This metamodel is linked to the MEGA 



5

Introduction
Presentation of HOPEX SAP Blueprint

Process metamodel in order to match Business modeling data with SAP 
Solution Manager data.
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PRESENTATION OF SAP SOLUTION MANAGER

Concepts Used in SAP Solution Manager

SAP provides a wide range of enterprise software applications and business
solutions to empower all aspects of businesses. In its offering, SAP uses the concept
of process blueprints which are project-based process structures to help implement
and maintain its solutions such as ERP, CRM, SCM, etc. These blueprints are
maintained with the SAP Solution Manager tool.

SAP Solution Manager can be used to evaluate and implement solutions. This is done
through projects. 

Each project has:
• a system landscape

A system landscape is composed of an arbitrary number of components
which are referenced by process steps and transactions.

• a Blueprint structure
Business Blueprints are used to document the business process
requirements of companies and give a general idea of how business
processes could be mapped in SAP Systems. 

The Blueprint in Solution Manager is a hierarchical tree. At the top of the hierarchy
is the Project (where project is the name of the SAP Solution Manager project).
There are three levels to this hierarchy:

• Project level: Contains Master data, Organizational units, Business 
Scenarios

• Scenario level: Contains Organizational units, Master data, Business 
Processes

• Process level: Contains Process steps
Entities called transactions are commonly included in Process steps but
may also be attached to Processes and Scenarios.
This is the SAP view of business processes. This hierarchy is supported
and reproduced in HOPEX SAP Blueprint.
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Below is a diagram illustrating the SAP Solution Manager metamodel.

SAP Solution Manager metamodel

The content of this structure is connected to the business view and maintained in
sync with its equivalent in SAP Solution Manager by the MEGA/SolMan Exchange
Module.

Overview of SAP Solution Manager

Let us take a quick look at how projects are presented in SAP Solution Manager.
1. Log on to SAP Solution Manager (Start > Programs > SAP Front End 

> SAP Logon).
2. Select a server and click Logon.
3. Enter the user name > password and press the <Enter> key.

 If Solution Manager does not automatically start, run the "solar01" 
transaction (below the menu bar, enter solar 01 in the field left of the 
diskette and click the check button).
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By default, the last project used by the user opens.

The project in this example is the Project SOLIMP1001 MEGA while the Project ID is
TMIDEVEL02.

The content of the project, such as the scenarios, business processes and processes
are presented in a tree hierarchy to the left of the window. The objects to be
exchanged with HOPEX are in this tree. When objects exist but are not displayed
in the tree, this is indicated by a clock with a green checkmark.

In exchanges, the same tree structure is displayed in HOPEX.
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When you click on an object in the tree, information relating to this object is
displayed in the corresponding tabs in the right frame.
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EXCHANGING DATA WITH SAP

HOPEX SAP Blueprint enables to exchange SAP objects between HOPEX and SAP Solution
Manager.

In order to ensure consistency, the exchange is always performed on the basis of projects.

 "Import/Export Prerequisites", page 12
 "Importing/Exporting", page 14
 "Properties Exchanged between MEGA and SAP Solution Manager", page 17

 Before exchanging data, make sure the appropriate components 
were installed. Refer to the "MEGA SolMan installation guide". 
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IMPORT/EXPORT PREREQUISITES

Activating Variations

Before importing/exporting, it is advised to activate variations in HOPEX SAP
Blueprint.

 Variations are necessary to be able to view object versions and 
differences.

(Windows Front-End) To activate variations:
1. Log in to HOPEX and from the HOPEX desktop, select Tools > 

Options. 
2. In the Business Process and Architecture Modeling group, select the 

Activate variations option. 

(Web Front-End) To activate variations:
1. Log in to HOPEX and from the HOPEX desktop, select Main Menu > 

Settings > Options. 
2. In the Business Process and Architecture Modeling group, select the 

Activate variations option. 

Import/Export Settings

To set the import/export settings:
1. Log in to HOPEX.
2. From the HOPEX desktop select:

• (Windows Front-End) Tools > SolMan Exchange.
• (Web Front-End) Main menu > SolMan Exchange.

3. In the wizard that appears, click Options.
A dialog box appears.

You must complete the settings before the import/export can take place.
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Some of these settings directly correspond to the settings used for connection to
SAP Solution Manager with the SAP Front End: 

• Application Server
• Instance Number
• System Id: number corresponding to the SAP system used
• Client: SAP client number
• Language: exchange file language

Other settings are available:
• Check Consistency: activates the consistency modeling rules for the 

project being exchanged. 
• If selected and an invalid consistency rule is encountered when the 

exchange process is launched, this process is automatically aborted 
and no exchange takes place. 

• If left unselected: the exchange takes place if the data is correct. If 
the data is incorrect, the exchange process fails.

• Check Mapping: activates the mapping modeling rules for the project 
being exchanged. 
• If selected and an invalid mapping rule is encountered, the exchange 

process is aborted. 
• If left unselected: the exchange takes place if the data is correct. If 

the data is incorrect, the exchange process fails.
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IMPORTING/EXPORTING 

Importing/Exporting a Whole Project

To import or export a project:
1. From the HOPEX desktop select:

• (Windows Front-End) Tools > SolMan Exchange.
• (Web Front-End) Main menu > SolMan Exchange.

2. In the window that appears, enter the Login and Password of the SAP 
user with the appropriate authorization.

3. Click Next.
4. In the Select a project field, enter the Project ID of the project you 

want to import from SAP Solution Manager or export from HOPEX.

 To obtain a project ID, see "Obtaining a Project ID in SAP Solution 
Manager", page 18.

5. Select the exchange method considered:
• Import: selected by default. 
The first time you use HOPEX SAP Blueprint, you must import a project
from SAP Solution Manager as you cannot create SAP projects in HOPEX.
• Export

 The Project being exchanged must not be edited in SAP Solution 
Manager during the exchange.

6. If you want to import/export some scenarios only, select the Partial 
Import/Export check box.

 For more details about this option, see "Importing/Exporting 
Scenarios", page 15.

7. Click Next.
The project data import/export is being launched. 
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8. Click Finish.
 If the exchange does not start or you have an error message:
• verify your import/export settings. For more details on the 

exchange settings, see "Import/Export Prerequisites", page 12.
• view the trace file: from the HOPEX workspace, select ? > About 

MEGA. Click the System Information button then Error Log > 
Edit.

Importing/Exporting Scenarios

You can import or export only part of a project by selecting the scenarios which are
of interest to you.

To import or export scenarios:
1. See "Importing/Exporting a Whole Project", page 14.
2. In the import/export wizard, select the Partial Import/Export check 

box.
 To access the import/export wizard, see "Importing/Exporting a 
Whole Project", page 14
 This check box is not selected by default.

3. Click Next.
4. From the list of scenarios listed, select "Yes" in the Import/Export 

drop-down list.
 For more details about the scenarios listed, see:
• "Importing scenarios", page 15
• "Exporting scenarios", page 16

 You must select at least one scenario here. 
5. Click Next.

Depending on the action selected, the import or export is being launched. 

Importing scenarios

When you choose to import a project partially, the list of scenarios listed is built from
the SAP server.

You can import a scenario:
• regardless of its presence or absence in the MEGA repository, 
• even if the corresponding project still does not exist in the MEGA 

repository.
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Only the objects located below the selected scenarios are updated. 

Exporting scenarios

You can export scenarios which have never been exported before.

When you export a project partially, the SAPId of the objects located below the
selected scenarios are updated.
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PROPERTIES EXCHANGED BETWEEN MEGA AND SAP 

SOLUTION MANAGER

The data exchanged between HOPEX and SAP Solution Manager through the
import/export tool is contained in the SolMan project.

SolMan projects are identified in HOPEX and SAP Solution Manager through their
SAP IDs. 

As SAP IDs cannot be generated in HOPEX it is important that data imported
into HOPEX retain their SAP IDs so that when exported to SAP Solution Manager,
the objects with the same SAP ID in Solution Manager can be updated. 

As such, objects imported into HOPEX:
• are assigned HOPEX IdAbs
• still retain their SAP IDs. 

 The HOPEX IdAbs value is not directly available on the object as an 
attribute in SAP Solution Manager. 

SAP Identifiers

Objects created in SAP Solution Manager are automatically assigned SAP IDs.

When objects created in SAP Solution Manager are imported into HOPEX, the
values of these identifiers are kept.

 SAP IDs cannot be generated in HOPEX so the SAP ID attributes 
values for objects created in HOPEX remain empty.

Automatic specification of SAP IDs

To automatically specify SAP IDs:
 Export the SolMan project from HOPEX SAP Blueprint into SAP 

Solution Manager.
IDs are automatically specified in SAP Solution Manager. 
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Obtaining a Project ID in SAP Solution Manager

To obtain a SAP project ID:
 In SAP Solution Manager, click the Other Project button or press 

<Shift+ F5>. 
A pop-up window appears with the list of projects. The current project is
highlighted. The project ID number is displayed in the Project column.

Accessing a Project ID in SAP Solution Manager

MEGA Identifiers

Objects created in HOPEX do not have SAP IDs. 

HOPEX IDs are however assigned to objects created in HOPEX and those that
define projects imported from SAP Solution Manager. 

Importing a SAP Solution Manager project into HOPEX

When you import a Solution Manager project into HOPEX:
• If no HOPEX identifier is specified, the object is created.
• If HOPEX identifiers are specified and the object already exists in 

HOPEX, it is updated. 
• If the object does not exist, it is created with the specified HOPEX 

identifier.
 When importing Solution Manager projects into MEGA, the MEGA 
identifier of the newly created objects are automatically transfered to 
SAP Solution Manager at the end of the import. 
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Exporting a SolMan project from HOPEX

SolMan project objects exported from HOPEX have HOPEX IDs. When these IDs
are imported into SAP Solution Manager via the HOPEX connector, they are:

• kept and restored when the project is exported from SAP Solution 
Manager

• re-imported into HOPEX.
 When exporting SolMan projects from MEGA, the SAP identifier 
associated to the created object in SAP is automatically transfered to 
MEGA at the end of the export. 

Names in HOPEX SAP Blueprint

Object names are managed through two different attributes: 
• HOPEX Name
• SAP Name

Managing two attributes in HOPEX:
• Facilitates keeping SAP names and using different names in HOPEX
• Follows the rule of name uniqueness in HOPEX. If this rule is not 

followed for objects coming from SAP Solution Manager, the names of 
these objects are automatically modified in HOPEX.

When you change one of these attribute values, this does not affect the other.

When projects and their data are imported/exported into/from HOPEX, the SAP
name does not change.
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When exporting from HOPEX to SAP Solution Manager:
• If a SAP name is specified for an object in HOPEX, the SAP name 

remains the same in SAP Solution Manager.
• If no SAP Name is specified for an object in HOPEX, the HOPEX name 

(Local name) is taken into account in the export and becomes the name 
of the object in SAP Solution Manager.

Namespace rules

When naming objects in HOPEX a particular namespace rule applies for the SolMan
metamodel.

According to this rule, no two objects of the same MetaClass can have the same
name. 

If you try to give an object a name that is already assigned to an object of the same
MetaClass:

• the name is automatically modified. 
• The string "-1" or "-[n]" is added to the name, where [n] is a number 

that makes the name unique. 
 The value of n is incremented by 1 each time you try to the name.

Example 
Two SolMan Processes exist in a SolMan Scenario and are 
called "P" and "P-1". If you try to give a new SolMan 
Process the name "P", the name "P-2" will automatically be 
assigned to the new object.

This automatic behavior occurs when SolMan projects are 
imported into HOPEX.
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DESIGNING FOR SAP PROJECTS

SAP represents certain businesses in projects which are further subdivided into Business Scenarios,
Business Processes, Process Steps and Transactions. They also include Master Data and
Organizational units. All these objects are presented in a hierarchy in SAP Solution Manager.

HOPEX SAP Blueprint offers the possibility of presenting the SAP hierarchy in HOPEX to map
business processes modeled in HOPEX with the information in SAP. The hierarchy structure in SAP
Solution Manager is exported to HOPEX SAP Blueprint and seen identically in both products. You
then have the option of modifying the projects to better meet business requirements by adding or
deleting objects.

HOPEX SAP Blueprint enables you to align SAP Solution Manager project lifecycle with HOPEX
through management of implementation, maintenance and template projects.

HOPEX SAP Blueprint also enables you to initialize a SolMan project from business objects and
populate a diagram from a SolMan structure.

 "Accessing SolMan Data in HOPEX", page 22
 "Managing Projects", page 27
 "Aligning SAP Project Lifecycle with HOPEX", page 48
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ACCESSING SOLMAN DATA IN HOPEX

Once the SolMan projects have been imported into HOPEX, they can be viewed in
the Solution Manager navigation window.
Three types of projects can be viewed in HOPEX SAP Blueprint:

• Implementation projects

 An implementation project is used to implement business processes 
in an SAP landscape.

• Maintenance projects

 A maintenance project is used to maintain changes in the 
productive environment (solution).

• Template projects

 A template project is used to create and distribute a template 
defining the project structure.
 For more information about these project types, see "Overview of 
SAP Solution Manager Lifecycle", page 48.

You can also launch an SAP transaction directly from HOPEX SAP Blueprint. 
 See "Viewing a Transaction", page 25.



23

Designing for SAP Projects
Accessing SolMan Data in HOPEX

Viewing SolMan Projects in HOPEX

Accessing SolMan projects

To view SolMan projects:
 In HOPEX Windows Front-End desktop select Navigation Windows 

> Solution Manager.
 In HOPEX Web Front-End Enterprise Architect desktop, from the main 

navigation menu select Solution Manager.
The "Solution Manager" navigation page appears. 

The Hierarchy View displays the repository in which you are working.

Contents of the Hierarchy View
All the projects created during imports can be found in a folder of the Solution
Manager navigation window. The folder depends on the type of projects imported.
Three types of projects are available:

• Implementation Projects
• Maintenance Projects
• Template Projects

 Below is described the hierarchy of implementation projects. The 
same hierarchy applies to maintenance projects and template projects.
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To access data from imports:
 Expand the folder corresponding to the type of project imported then the 

project folder required to view the hierarchy.

The hierarchy represented here reflects what is actually managed in the
corresponding view of SAP Solution Manager.
The objects managed are:

• SolMan Projects
• SolMan Organizational Units
• SolMan Master Data
• SolMan Scenarios
• SolMan Processes
• SolMan Process Steps
• SolMan Transactions

The displayed hierarchy is almost the same as that displayed in SAP Solution
Manager except that transactions are displayed here. 
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The icons corresponding to the different objects in an SAP Project are displayed in
the table below.

 For more information about how to handle these objects, see 
"Managing Projects", page 27.

Viewing a Transaction 

You can view a transaction screen directly from HOPEX SAP Blueprint. 
 SAP GUI thick client must be installed on the workstation.

Defining settings for transaction launch
Before viewing a transaction, you need to define the settings required for
authentication.

To define settings for transaction launch:
1. Access the SolMan project.

 See "Viewing SolMan Projects in HOPEX", page 23.
2. Right-click the SolMan project and select Properties.

Object type Icon Owner object

Scenario Project

Organizational Unit Project , Scenario

Master Data Project, Scenario

Process Scenario

Process Step Process

Transaction Process Step, Pro-
cess, Organizational 
Unit, Master data
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3. In the SolMan Project Transaction Launch tab, specify the settings as 
follows:
• Configured SAP Login: SAP client number
• SAP Language
• Server
• System Number
• System ID
• Client

 These settings directly correspond to the settings used for 
connection to SAP Solution Manager with the SAP Front End.

Launching a transaction

To launch a transaction:
 From a SolMan project properties, right-click a transaction and select 

Launch SAP Transaction.
The transaction screen is displayed in HOPEX SAP Blueprint.

 This feature is not available in HOPEX Web Front-End.
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MANAGING PROJECTS

The procedures and indications given below apply to:
• implementation projects
• maintenance projects
• template projects

 For procedures specific to maintenance and template projects, see 
"Aligning SAP Project Lifecycle with HOPEX", page 48. 

About SolMan Projects

In SAP Solution Manager, components are used to:
• host transactions
• support processes

To ensure that processes and transactions are attached to components in a project,
the components used in the project must first be defined. The system Landscape of
the project defines these SAP logical components.
For this reason SolMan projects cannot be created in HOPEX. They must first be
created in SAP Solution Manager with their appropriate system landscapes and then
imported into HOPEX, even if no scenarios are selected in SAP Solution Manager.
After this first import, the project and its logical components are defined in HOPEX
with their correct SAP IDs.

Modifying SolMan Objects

Before modifying a SolMan object, you need to check whether it can be modified or
not. Some objects of the imported projects cannot be modified. You can identify
them thanks to the  icon.
You first need to activate indicators showing the objects that cannot be modified.

Viewing objects that cannot be modified

To be able to view objects that cannot be modified:
1. From MEGA desktop, select:

• (HOPEX Windows Front-End) Tools > Options.
• (HOPEX Web Front-End) Main menu > Settings > Options.

2. In the left tree, select Status Indicators.
3. Select the Indicate objects that cannot be modified check box.

 There is also an indicator showing the objects that can be modified.
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When an object cannot be modified by the current user, a symbol representing a
closed padlock is displayed:

• In diagrams: the symbol  is displayed under the object. 
• In a tree: the symbol  is displayed on the right of the object name.

When an object is locked, the Immutability attribute displays the "Locked" value.
 This attribute can be viewed in the General tab of the property 
page when you are in Expert metamodel mode (Options > 
Respository > Metamodel Access > "Expert").

Motives for automatic object locking
There are different reasons for which an object is automatically locked by HOPEX
SAP Blueprint.
An object is locked:

• if a new version of the object has been created.
 For more information about variations, see "Viewing project 
versions", page 53.

• if the object displays a value (any value) in SAP Global Attribute 
 This attribute can be viewed in the Characteristics tab of the 
property page.

• if, within the framework of a maintenance project, the object that is part 
of a solution is not checked-out. This applies to scenarios, processes or 
process steps.

 For more information about maintenance projects, see "Managing 
Maintenance Projects", page 52.

• if, when importing a transaction, the transaction parent is locked.

The System Landscape Attributes of a SolMan Project

You can define SAP Components that define a System Landscape from the System
Landscape properties window. This window can be accessed from the SolMan
project.

To define SAP Components that define a System Landscape:
1. Acess a SolMan project.
2. See "Viewing SolMan Projects in HOPEX", page 23.
3. Right-click the SolMan project and in the pop-up menu that appears, 

click Properties.
4. In the properties window of the project, select the Defined System 

Landscape tab.
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5. To the right of "Defined System Landscape" field, click the arrow  and 
select Defined System Landscape > Properties.

The Properties window of the SAP System Landscape appears.

Components that define the System Landscape are displayed in this window. 
 It is highly recommended that you neither add nor delete SAP 
Components in HOPEX. This should be done in SAP Solution Manager. 
During the next synchronization the System Landscape in HOPEX is 
aligned with the System Landscape updated in SAP Solution Manager.

Activating/Deactivating SolMan Objects

SAP provides many Scenarios with many Processes. Not all these objects are
relevant to any given Project. As such, SAP Solution Manager offers the possibility
of activating or deactivating these objects according to Project requirements.
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All objects imported from SAP Solution Manager can be activated or deactivated
within HOPEX. This is done with the "Is Active" attribute that can be found on
objects of the following MetaClasses:

• SolMan Scenario
• SolMan Organizational Unit
• SolMan Master Data
• SolMan Process
• SolMan ProcessStep
• SAP Transaction

The "Is Active" attribute corresponds to the same attribute in Solution Manager. It
is used to activate/deactivate objects of the SAP system.

To set the "Is Active" attribute:
1. In the Solution Manager navigation tree right-click an object.
2. In the pop-up menu that appears select Inactive.
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The object now appears with a red cross indicating its inactive state. When objects
are Active they are displayed with a green checkmark.

The "Is Active" attribute behaves as follows:
• If an object is deactivated, all its sub-objects are inactive.

 When an object is deactivated, all its sub-objects are seen as 
deactivated however their active state is restored when this object is 
reactivated.

• If an object is activated, all its super-objects are activated.
 When you activate an object, the objects above this object in the 
tree, including the parent object, are also activated.
 The Active/Inactive status associated to each SolMan object 
indicates whether or not the object (and its sub-hierarchy) is to be used 
in the project. Inactive objects are not used in projects but are still 
present in the project and are still exchanged between HOPEX and SAP 
Solution Manager. At any moment during the project, inactive objects 
can be activated.

Adding SolMan Objects

Project requirements cannot always be met by simply selecting from the standard
objects provided by SAP. Sometimes you may be required to add new objects that
do not exist in SAP. HOPEX SAP Blueprint allows you to insert new objects in the
project hierarchy. 
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However, as projects and their System Landscapes must be created in SAP
Manager, the objects that can be added in HOPEX SAP Blueprint are restricted to:

• SolMan Scenarios
• SolMan Master Data
• SolMan Organizational Unit
• SolMan Process
• SolMan ProcessStep
• SAP Transaction

To insert a new object in the project hierarchy:
1. See "Viewing SolMan Projects in HOPEX", page 23.
2. In the Solution Manager navigation tree, select the parent object 

where the new object is to be inserted.
3. Right-click this parent object and select the appropriate object type in 

the New menu.

A creation dialog box appears. 
4. Enter the name of the new object in the dialog box and click OK. 

The new object appears in the hierarchy
5. Right-click the new object and in the pop-up menu, select Properties to 

open the properties dialog box.
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6. Enter the name of the Component that supports the object (Supporting 
Component). 

 You can either create a new component or find a component that 
already exists.
 You can only add supporting components for Process Steps and 
Transactions.

The new object has no SAP IDs. The SAP IDS will be assigned by SAP Solution
Manager during the next synchronization. Once assigned, these IDs must not be
changed.

 When you create new objects, you do not need to explicitly select 
the "Is Active" attribute. By default, the object inherits the value of the 
parent object.

Retrieving Objects Not Present in SAP Solution Manager

Objects that are present in HOPEX SAP Blueprint but which have been deleted
from SAP Solution Manager can be found in a specific folder during the import from
SAP Solution Manager into HOPEX SAP Blueprint.
if objects are deleted from a project in SAP Solution Manager and this project is then
imported into HOPEX, these objects are not automatically deleted in HOPEX SAP
Blueprint. They are instead marked as unfound in SAP Solution Manager. This is
the case for links between the object and its project.

 These links are displayed in the Solution Manager navigation 
window in the "Objects not present in SolMan" sub-folder of a project 
folder. All the links that existed on the object before the synchronization 
are kept in HOPEX SAP Blueprint. The objects deleted in SAP Solution 
Manager are therefore still present and in their original place in HOPEX 
after the synchronization. 
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Accessing objects deleted from SAP Solution Manager

To access objects deleted from SAP Solution Manager:
 From a project, unfold the Objects not found in SolMan folder.

These objects will no longer be exchanged during an export to SAP Solution Manager
and will not be recreated in SAP Solution Manager either. 
You can choose:

• to keep the objects not found in Solution Manager
• to delete them

Deleting the objects not found in SAP Solution Manager

To delete objects that have not been found in SAP Solution Manager:
 Right-click on a project, and select Delete SolMan Objects Not Found 

in SAP Solution Manager.

All the objects, documentation types and statuses not found in SAP
Solution Manager are deleted. 

 For more information about documentation types and statuses, see 
"Managing MEGA document classification", page 45.

Deleting SolMan Objects

SAP covers a wide variety of business cases, by far much more than a company
needs. As all objects are not necessary for all projects, project teams need to know
which objects will definitely not be used. Once this has been decided, the objects
that do not correspond to the company’s context can be deleted in HOPEX and in
SAP Solution Manager.
The HOPEX SAP Blueprint view is a real hierarchy so deleting one object of this
hierarchy also deletes all its sub-objects at the deepest level.

To delete an object:
1. See "Viewing SolMan Projects in HOPEX", page 23.
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2. In the Solution Manager navigation tree, right-click the object to be 
deleted.

3. In the pop-up menu that appears, select Delete.
A deletion window appears. All the objects that will be deleted are
presented with a check box. 

4. Click Delete. 
The object and all its sub-objects have disappeared from in the Solution Manager
navigation tree.

Mapping SolMan Objects with Business Objects

Objects of the SolMan hierarchy can be linked to objects of the business view
according to the correspondence table below.

 SolMan Concept  HOPEX Concept

Project Library

Scenario Business Process
Organizational Process
Functional Process
Activity
Task
System Process
Business Function
Operation

Process Business Process
Organizational Process
Functional Process
Activity
Task
System Process
Business Function
Operation

Process Step Business Process
Organizational Process
Functional Process
Activity
Task
System Process
Business Function
Operation

Master Data Content
Data Model
Package

Organizational Unit Org-Unit

Transaction IT Service
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Mapping
HOPEX business objects that have been linked to SolMan Objects in the project are
placed in the "Mapping" folders of the Solution Manager navigation window. 
Because of this one-to-one correspondence and the related identification issue,
objects cannot be moved around from one place to another in HOPEX SAP
Blueprint. They can only be created, duplicated or deleted.

You can map objects:
• in SolMan diagrams
• in the navigation window

In the navigation window

To map objects in the navigation window:
1. In the Solution Manager navigation window, select the SolMan object 

to be mapped and unfold it. 
Its mapping folder appears.
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2. In the Objects navigation window, select the business object to be 
mapped then, drag and drop it into the Mapping folder of the Solman 
object. 

The mapping is established.

When you map a HOPEX object with an SAP Solution Manager object, its sub-
objects (owned objects) are not automatically mapped with the sub-objects of the
associated SAP Solution Manager object. 
In the above example, an organizational process is mapped with a scenario. The
sub-objects of the organizational process are displayed in the Solution Manager
navigation window under the scenario, however, none of them are linked to any of
the scenario’s sub-objects. The sub-objects must be explicitly mapped like the
business object and the scenario, by dragging and dropping the business object
sub-objects in the Mapping folder of the concerned scenario sub-object. 

In a SolMan diagram
You can map HOPEX business objects with SAP Solution Manger objects in a SolMan
diagram.



38 HOPEX SAP Blueprint

2

To create a diagram in HOPEX SAP Blueprint:
1. Right-click the SolMan object that contains the objects to be mapped. 

This can be a project, a scenario or a process.
2. In the pop-up menu that appears select New > Diagram.
3. In the dialog box that appears, select the SolMan Diagram type and click 

on the Create button.

To map HOPEX and SolMan objects:
1. In the object bar select the icon corresponding to a HOPEX object 

(Process, Operation, etc.) and click in the diagram.
2. Create the HOPEX business objects and place them in a vertical line in 

the in the diagram.
• Click the arrow of the Name field and search for the object to be 

added in the repository.
 You cannot create new items in SolMan diagrams. If you want to 
add an object that does not exist, you must first create it in the correct 
navigation tree. 

• Click Connect.
The object appears in the diagram.

3. Create the SolMan objects and place them in a vertical line to the other 
side of the diagram.

4. In the object bar, select the Link icon and click in the diagram on the 
first object to be mapped.

5. Without releasing the mouse button, draw a line to the second object to 
be mapped then release it.
Once mapped, the HOPEX objects  appear  in  the  Solution  Manager
navigation window, under the SolMan objects.
In the figure below, the "Product Classification (Compliance)" Business
Process is mapped with the "Classify shipment" operation.
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Example of a SolMan Diagram

Initializing a SolMan Project from Business Objects

A specific wizard enables initialization of contents of a SolMan project from business
objects i.e. HOPEX objects. It consists in transforming a BPMN diagram into a
SolMan structure.
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Prerequisites
Before launching the wizard, you need to make sure:

• the object from which you want to launch the wizard is already mapped 
with a HOPEX SolMan element.

 For more information on mapping, see "Mapping SolMan Objects 
with Business Objects", page 35.

In the example below, the "Purchasing" business process is 
mapped to the "Credit Risk Management" Solman scenario.

• you have created a parameter file indicating the mapping levels between 
MEGA objects and Solman elements. For more information, see "Creating 
a parameter file", page 40.

Creating a parameter file

Before launching the wizard, you need to create a parameter file which specifying
the mapping levels between MEGA objects and Solman elements.

Location of the parameter file
The "megasolmanbusinessimport.ini" file should be located in the USER folder of the
appropriate environment:
<Environment>\Db\<Repository>\USER\<User name>

Syntax used
Parameterization is found in a [MetaAssociationEnd] section.
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The syntax is as follows:
[Metaclass field]=[MetaAssociationEnd1 
field];[MetaAssociationEnd2 field];[MetaAssociationEnd3 
field]

 The list of MetaAssociationEnds are those to browse from the 
MetaClass occurrence. The sub-objects taken into account are those 
obtained by the defined link.
 A * sign before the MetaAssociationEnd means there is a change in 
mapping level.

In the event of a change in mapping level:
• If the owner was mapped wih a SolMan Scenario, the object is mapped 

with a SolManProcess
• If the owner was mapped with a SolMan Process, the object is mapped 

with a SolMan ProcessStep
• if the owner was mapped with a Solman ProcessStep, the object is 

mapped with a SolMan Transaction

Example
[MetaAssociationEnd]
~pj)grmQ9pG90[Business Process]=~Zs()h50XBn70[Owned Business
Process];*~6R65VIXKpG10[Organizational Process] 
~gsUiU9B5iiR0[Organizational Process]=*~prUiaCB5iOB2[Operation] 

 In the above example the sub-processes of the process from which 
you want to initialize the wizard must be owned by the process.

Launching the wizard

To launch the wizard:
1. Open a BPMN diagram, for example a business process diagram.

No change in mapping level The SolMan element created is of the same type as the 
SolMan element mapped with the parent MEGA object.

Change in mapping level (* before 
the MetaAssociation)

The SolMan element created is of a lower level than the 
SolMan element mapped with the parent MEGA object.
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2. Right-click on the root HOPEX object from which you want to initialize 
the Solman project and select Initialize Solman Project.

 The HOPEX object from which you want to initialize the project 
must be already mapped with a Solman element. For more information, 
see "Prerequisites", page 40.

For this object and all the sub-objects below, an object is created in the
Solman hierarchy. 

In the example above:

- A business scenario named "Purchasing" is created and 
mapped with the "Purchasing" business process. 

- A business scenario named "Operational Purchasing" is 
also created and mapped with the owned business process 
"Operational Purchasing" 

- A SolMan Process named "Standard Purchase Process" is 
created and mapped with the organizational process 
"Standard Purchase Process" 

Hierarchy of SolMan objects created
The Solman hierarchy is created according to the structure defined in the parameter
file. 

 For more information about the parameter file, see "Creating a 
parameter file", page 40.

A business process produces a scenario. 
The sub-processes could produce:

• a SolMan Scenario if there is no change in mapping level
• a Solman Process if there is a change in mapping level (*)

 You can launch the wizard several times while designing your 
diagram. Updates in your diagram are transfered to your new SolMan 
structure.
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Generating a report
A report gives you an overview of the business objects that have been mapped to a
SolMan object. 

 For more information, see "Solman Project Mapped Element 
Report", page 71.

Populating a BPMN Diagram from a Solman Structure

You can update a BPMN diagram by drag and dropping elements from a Solman
structure.

To update a BPMN diagram:
1. From the Solution Manager navigation window select an element and 

drag it to the BPMN diagram you want to update, for example a business 
process diagram.
A wizard asks you which object type (metaclass) you want to use to create
the corresponding object.

2. In the Mapping Metaclass frame, select an object type, for example 
"Functional Process".
A new object is created, with "SAP" indicated on the shape.

3. Create in the same way the different objects needed in your diagram.
 If at some point you cannot drag-and-drop objects, close your 
diagram and reopen it.

4. Arrange your diagram and create links betweens objects accordingly.
 If you try to drag-and-drop an object that has already been created 
in the diagram, the wizard asks you if you want to:
• create a new mapping object
• use an existing mapping object
 If you delete an object in the HOPEX SAP Blueprint hierarchy, the 
corresponding object in the BPMN diagram is not deleted.

You have created a BPMN diagram from a SolMan structure.
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Exchanging Documents Between HOPEX SAP Blueprint and SAP

It is possible to:
• create links to the URL documentation of SolMan objects so that they can 

be viewed from SAP Solution Manager
• access SAP Solution Manager documents of URL type from HOPEX SAP 

Blueprint through external references
• categorize the documents sent by HOPEX SAP Blueprint according to 

SAP classification. 

Creating links to the URL documentation of SolMan objects
You can create links to the URL documentation of SolMan objects allowing you to
view these in HOPEX Explorer.

To activate links to the URL documentation of SolMan objects:
 In the properties dialog box of SolMan projects, select the Website Link 

Synchronizaton tab.

The generated links are a result of mapping links in HOPEX. 

Example
If in HOPEX a SolMan Scenario is mapped with an organizational process, a
documentation link towards the HOPEX Advisor page of the organizational process
is added in SAP Solution Manager at the next synchronization of the corresponding
Scenario.

Pointing to dynamic Web sites
You can point to a dynamic Web site (HOPEX Advisor).
To specify access in SAP Solution Manager through dynamic Websites:

 Select the Dynamic WebSite Links Generation check box.

To specify the root address of dynamic websites:
 Enter the URL address in the Dynamic WebSite URL Root field.

Pointing to static Web sites
You can point to a static Web site.
To specify access in SAP Solution Manager through static Websites:

 Select the Activate Static WebSite Links Generation check box.
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Accessing SAP Solution Manager Documents from HOPEX SAP Blueprint
SAP documents of URL type appear in HOPEX SAP Blueprint as external
references after being imported from SAP Solution Manager:

These external references appear if you have:
• created documents for SolMan objects in SAP Solution Manager 
• mapped SolMan objects with HOPEX business objects 

Managing MEGA document classification
In SAP Solution Manager, documents have a specific classification. 
By default, MEGA documentation originating from mapping is classified under
"Additional documentation". You can categorize MEGA documents so that they
appear in one of the categories of the SAP Solution Manager project.
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Viewing document classification

To view the documentation statuses and types available on the SolMan project:
 In the SolMan project properties dialog box, select the Documentation 

Classification tab:

 The values are those created initially in SAP Solution Manager.

Specifying document classification
You need to specify the default classification of documents on the project.

To specify the default classification of project documents:
1. In the properties dialog box of a SolMan project, select the Website 

Link Synchronizaton tab.
2. Specify:

• SolMan Default Document Status
• SolMan Default Document Type

You can also modify the classification on an individual document.

To modify classification of HOPEX documents on an external reference:
1. in HOPEX SAP Blueprint, from a SolMan object, unfold the 

Documentation folder, right-click the external reference and open its 
properties dialog box.
You can modify the desired values for:
• Solman Document Status
• Solman Document Type
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2. Select another documentation type.

Example of values for Solman Project Documentation Status

 Note the values are those created initially in SAP Solution Manager.
When data is exported, the documentation classification value is modified
accordingly in SAP Solution Manager.
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ALIGNING SAP PROJECT LIFECYCLE WITH HOPEX

When a project changes statuses during its SAP lifecycle, new objects are created.
The issue here is that HOPEX mapping is lost. 
As a consequence, it may not be possible to use the initial documentation produced.

 For more information about mapping and documentation, see :
• "Mapping SolMan Objects with Business Objects", page 35
• "Exchanging Documents Between HOPEX SAP Blueprint and SAP", 

page 44.
HOPEX SAP Blueprint provides a means to trace the changes back to the initial
implementation projects through versioning.

 Versioning is a HOPEX platform feature that is fully described in 
the HOPEX Common Features user guide. For more information, see 
chapter "Handling Repository Objects", paragraph "Object Versions". 
See also "Viewing project versions", page 53.

Overview of SAP Solution Manager Lifecycle

The following summarizes the main project types found in SAP Solution Manager.

 "Managing Implementation Projects", page 49
 "Managing Maintenance Projects", page 52
 "Managing Template Projects", page 55
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Managing Implementation Projects

The lifecycle of an SAP solution typically starts with an implementation project
for blueprinting, customizing, developing, testing and roll-out (which is reusing
existing implementation in a new location). 

 An implementation project is used to implement business processes 
in an SAP landscape.

After an implementation project is carried out, it becomes a solution in SAP Solution
Manager.

Importing a project
For more information on project import, see "Importing/Exporting", page 14.

Viewing the differences with the template project
If the implementation project is based on a template project, HOPEX SAP
Blueprint allows you to view the differences between them.
When importing the implementation project, versions of the project are created to
track the changes made in relation to the originating template project.
Technically speaking, versioning involves:

• creating variations
• locking the versioned object. 

You therefore need to be able to view variations.

Viewing variations
To be able to view versions, you need to activate variations (as versioning relies
partly on variations). For more information, see "Activating Variations", page 12.
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To view an object version:
 In the property page of a the SolMan project select the General tab then 

the Variations sub-tab.

Viewing the differences via a report
Versioning makes immediate change impact analysis possible. 
Reports make it easier to view the differences between objects. 

To access a report from the implementation project level:
1. Right-click the implementation project and select Report Discovery.
2. In the Available reports section, select SolMan Analysis.
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3. Alongside the SolMan Analysis Differences on Hierarchy report, 
select Launch a new report.

4. Click the title "Differences on Hierarchy" to refresh the report. 
The implementation project is a variant of the corresponding template
project. The report shows the differences between them and their sub-
elements.

 For more information onthe contents of this report, see "Hierarchy 
Differences Report", page 75.
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To access a report from a lower level element, for example from a a SolMan
Business scenario:

 Open the properties dialog box of the object and click the SolMan 
Differences tab.
The report shows the differences for the object and its first-level children.

 For more information on the contents of this report, see "Object 
Differences Report", page 74
 If you want a more global report on the whole project, see 
"Hierarchy Differences Report", page 75.

Managing Maintenance Projects

In the lifecycle of an SAP Solution Manager project, any change to the solution has
to be managed by a separate maintenance project. 

 A maintenance project is used to maintain changes in the 
productive environment (solution).

The branches of the business processes that need to be changed are checked-out
from the solution into the maintenance project. 
The project is then modified according to the required changes. After all changes
have been implemented, corresponding maintenance projects are checked-in back
to the solution.
Maintaining a SAP Solution Manager project therefore requires importing the
maintenance project into HOPEX SAP Blueprint.
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HOPEX SAP Blueprint keeps tracks of the changes to be able to update the
implementation project that gave birth to the solution. 
Note that the objects of a scenario that are not checked-out are locked.

Importing a project
For more information about project import, see "Importing/Exporting", page 14.

Viewing project versions
When importing the maintenance project, versions of the project are created to
keep track of the changes made in the maintenance phase.
Technically speaking, versioning entails:

• creating variations
• locking the versioned object. 

You therefore need to be able to view variations. For more information, see "Viewing
variations", page 49.

 A report makes it easier to view the differences between objects. 
For more information, see "Object Differences Report", page 74

Flagging objects for check-in
After you have modified an object in the project, you need to specify it is ready for
check-in in order to link it to the maintenance project.

 This step is necessary so that when concluding the maintenance 
project the objects are traced back to the corresponding implementation 
project.

To flag the object for check-in:
 Right-click the object modified and select SolMan maintenance > Flag 

for check-in.

Check-out status
The object must be in a proper check-in status to be flagged for check-in.
The statuses that are entitled for flagging for check-in are as follows:

• Check-in confirmed
• Check-in ready
• Check-out confirmed
• Check-out requested
• Checked-out
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If the object has a different status, a warning indicating that the check-out status
does not allow flagging for check-in appears.

 You can view the SolMan Checkout status in the Characteristics 
tab of the object property page.

Canceling check-in
You may decide later on that the object is not ready for check-in. 

To cancel check-in:
 Right-click the object that was flagged for check-in and select SolMan 

maintenance > Cancel check-in.

Concluding a project

To conclude a maintenance project:
 Right-click a project and select Conclude.

The objects that have been flagged for check-in are checked to the
solution.

 The objects that are already in the check-in path (meaning their 
parent is already flagged for check-in) are not processed here.

Impact of maintenance project conclusion on the implementation project
The implementation project is updated with the elements that were flagged for
check-in during the maintenance phase.
The maintenance project in HOPEX SAP Blueprint is emptied.
When you update an implementation project from a maintenance project:

• varied objects are disconnected
• variants are connected

 Traceability is kept in case you need to produce reports following 
project conclusion.
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Managing Template Projects

In complex environments with for instance several locations with country-specific
differences, several implementation projects may derive from a common template
project. 

 A template project is used to create and distribute a template 
defining the project structure.

Deploying a template project is a way to transform a project into a solution. When
a template project is deployed, the global processes defined in the templates are
said to be "localized".

 Managing SAP template projects and maintenance projects is very 
similar, except that the scope is larger when managing template 
projects. 

Importing a template project
When you need to modify a template project in SAP Solution Manager after it has
been deployed (that is to say used for other projects), you have to import it into
HOPEX SAP Blueprint. 

Here is what occurs in HOPEX SAP Blueprint when the template project is
imported.

• HOPEX SAP Blueprint detects the template project has been used for 
an implementation project.

• The template project is locked against changes made in other projects.
• A new version of every object of the template is created. 

Then you can make changes to the template project without impacting the original
implementation project.

 For more information about project import, see "Importing/
Exporting", page 14.

Project template versions
In HOPEX SAP Blueprint you obtain multiple levels of versions, as shown in the
figure hereafter. 
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A new version of the project template is created when:
• you import or synchronize a project template that has given birth to an 

implementation project 
• you import an implementation project based on a template project

 In the latter case, HOPEX SAP Blueprint connects the 
implementation project objects to the processes initially described in the 
template project. HOPEX SAP Blueprint creates new versions of the 
objects for each modification made in the new project.

Accessing previous versions of template projects 
Template contents is versioned in HOPEX SAP Blueprint after each new
implementation, that is to say after you have re-imported the project template into
HOPEX SAP Blueprint.

To access the initial template project :
1. see "Viewing SolMan Projects in HOPEX", page 23.
2. In the Template project folder, unfold the Previous version folder.
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DOCUMENTATION IN HOPEX SAP 
BLUEPRINT

When company projects include a lot of information, it is important to be able to consult this
information easily and if possible in different formats. HOPEX offers the possibility of generating
different documentation for the different projects in the company. The documentation can then be
managed and distributed as desired. 

 "MS Word Report Generation", page 58
 "Static Web Sites in HOPEX SAP Blueprint", page 59
 "Report Generation", page 62

For more information about documentation exchanged between HOPEX 
SAP Blueprint and SAP Solution Manager, see "Exchanging Documents 
Between HOPEX SAP Blueprint and SAP", page 44
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MS WORD REPORT GENERATION

In HOPEX, you have the possibility of generating reports (MS Word) of your SolMan
Project. 

To create a report (MS Word) of a SolMan project:
1. In the SAP Solution Manager navigation window, right-click the folder of 

the project concerned and in the pop-up menu that appears, select New 
> (MS Word) Report.
The creation dialog box appears. 

2. In the Name field, specify the name of the report (MS Word) to be 
created and select From report template (MS Word).

3. Select "SolMan Project Documentation" and click Next. 
The created report (MS Word) is based on this template.

4. Specify the location in which the created report (MS Word) is to be 
stored and click Next.

 If you so desire, in the dialog box that appears, you can enter the 
report (MS Word) distribution list. For more details on creating 
distribution lists, see the "HOPEX Common Features" user guide, 
"Generating Documentation" chapter, "Creating a Distribution List" 
paragraph. 

5. Click Finish.

The report (MS Word) is created in the Documentation navigation window,
Reports (MS Word) folder. 

It is automatically generated when created and opens. A specific toolbar and a
HOPEX menu appear in the report (MS Word).

You can do several things to the generated report (MS Word):
• Update it
• Revise it
• Distribute it for Review or Validation
• Detach it from MEGA 

 For more details on these options, see the "HOPEX Common 
Features" user guide, "Generating Documentation" chapter.
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STATIC WEB SITES IN HOPEX SAP BLUEPRINT

HOPEX offers the possibility of generating static web sites of the SolMan project.
This allows you to distribute the content of projects to enable people without access
to HOPEX to consult the objects of a project. 

The generated web site is based on a web site template.
 Web sites can be generated in HOPEX Windows Front-End only.

Creating a Web Site

 This feature is not available in HOPEX Web Front-End.

To create a web site of a SolMan project:
1. In the HOPEX desktop, select the Documentation navigation window.

 (Windows Front-End) If the Documentation navigation window is 
not visible in the workspace, in the HOPEX menu bar select View > 
Navigation Windows > Documentation.

2. In the tree, right-click the "Web Sites" folder and select New > Web 
Site.
The Create Web Site dialog box appears.

3. Enter the name of the Web site to be created.

4. Select a folder for generation by clicking the  button. 
By default, the Web site is generated in the "Intranet" folder. You are
advised to create a sub-folder for each generated Web site, for example
by creating folders with the same name as your Web site in the "Intranet"
folder.

 The content of the "Intranet" folder is deleted at each generation so 
when you have obtained a site with which you are satisfied and want to 
keep, copy it to another folder.

5. In the From Web site template list box, click the  button.
6. Select the "Enterprise Portal" Web site template and click Finish.

The new web site appears in the Documentation navigation window in the Web
Sites folder.

The new Web site has been created but not generated.

Before generating the Web site, you have the option of restricting the type of
objects to be included in the Web site. For example, you can decide to only generate
a project. If not, the Web site generation will include the entire repository and the
generation time will be lengthy. 
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Generating a Static Web Site

To generate the static Web site:
1. In the Documentation navigation window, right-click the new web site.
2. In the pop-up menu that appears, click Generate.

A dialog box indicates the progress of the generation. When the web site has been
generated, a dialog box proposes opening the web site.

 You can open the generated Web site at any time from the 
Documentation navigation window. In the Web Sites folder, right-
click the Web site and in its pop-up menu select Open.

Accessing the Web Site

To access SolMan project information:
 From the generated Web site click the SolMan tab.

The generated Web Site presents a view of the objects in the repository at the time
of the generation. Objects cannot be modified in the Web site. You can however
regenerate the Web Site at any time to include modifications made to objects in
MEGA repository. 

To navigate the Web site:
 Click on the links of each object which gives access to the corresponding 

pages. 

To return to the page previously consulted:
 Use the Back button in the main menu.
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Example of a static web site with a SolMan project
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REPORT GENERATION

In HOPEX, you can group sets of repository objects and study the interactions of
these objects to produce different reports. Reports are created from predefined
report templates.

Several report templates are provided with HOPEX SAP Blueprint.
 You can also create your own reports using the templates provided 
by HOPEX. The templates are available in HOPEX Windows Front-
End in the Utilities navigation window of the HOPEX workspace.
 For more information on creating reports, see :
• "Managing reports (Windows Front-End)", page 314
• "Managing reports (Web Front-End)", page 325

To access a SolMan report from an object:
1. In the Solution Manager navigation window, right-click the object on 

which you want to base the report (SolMan Project or mapped 
Organizational Process for example) and select Report Discovery.
A page appears with the list of all the reports available for the object.

2. Select the SolMan Analysis folder.
3. Click the Launch button next to the name of the report.
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The report is launched.

 You can also modify the report by clicking the Customize and 
Launch a new report button.

The report appears in the central window of the HOPEX workspace.

Reports for Organizational Processes

There are four reports available:
• Report Parameters
• SAP coverage rate
• Services of the organizational process
• SAP coverage

You can open a report by clicking on its name. 
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Report parameters

This report indicates the input data used for the report. In this example, this data
comes from the Import Compliance Validation organizational process.

SAP coverage rate

This report indicates the percentage of operations mapped to the SolMan project
through implemented services.

There are two parts to this report. In the first part, the legend is interpreted as
follows:

• SAP Support: percentage of operations that implement a service and are 
mapped with a transaction

• Other Systems: percentage of operations that implement a service but 
which are not attached to a transaction 

• No IT Support: percentage of operations that do not implement a service

In the example above, there are four operations. One operation implements a
service (SAP Support = 25%) while three operations do not (No IT Support = 75%).
There is no operation that implements a service and is not attached to a transaction
(Other Systems = 0%).
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The second part of the report has a different interpretation:
• SAP Support: represents the operations that are mapped with a SolMan 

object and implements a service which is mapped with a transaction
• Other Systems: represents all the operations that are mapped with at 

least one SolMan object 
• No IT Support: represents all the operations of the organizational 

process that are not mapped with a SolMan object (process, process 
step, etc.)

Services of the organizational process

This report lists all the operations of the organizational process and indicates the
services implemented by each of these operations.
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SAP coverage

The information of this report is arranged in tables.

This report is divided into three parts:
• a table that indicates the services implemented by operations and the 

SAP transaction to which the services are mapped. 
• a list of the SolMan processes that are mapped with an operation. It also 

lists the processes mapped with an operation the transactions of these 
processes.

• a table that recapitulates the first two parts of the report by displaying 
mappings between the SolMan objects and the operations. 

SolMan Updating Report

The SolMan Updating Report displays the changes made to SolMan projects from a
particular point in time in the current HOPEX transaction.
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Two parameters are considered for the report:
• A particular SolMan project
• A schedule (optional). If the schedule parameter is not defined, the 

report will show all modifications of the current transaction. All 
modifications will be displayed as "New" objects if the SolMan project 
was created in the current transaction.

The updates presented in the updating report therefore relate to:
• A MEGA object, in this case the SolMan project
• A dispatch: in this case only the updates relating to the dispatch are 

presented
• A schedule: this is used to define a period for the data extraction. If no 

end date is specified, the extraction concerns all updates from the start 
date. If a dispatch takes place the period defined by the schedule is not 
taken into account.

The SolMan Updating Report is generated on SolMan projects. You must launch the
generation from the SolMan project folder in the SolMan navigation window. 

There are two reports available:
• Report Parameters
• SolMan Updating

The SolMan Updating Report displays the project information in a tree. 
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The updates carried out on the SolMan project are indicated by specific icons. The
icons displayed depend on the type of changes made. The changes can include:

• Component and/or characteristic modifications to objects
• Creation or linking of objects
• Deletion or unlinking of objects

The icons are displayed in front of the object that has been modified. 

If an object in a project has been modified, an icon indicating that a change has
occurred appears in front of the project folder. Expand the project until you reach
the object that has been modified/created/deleted.

When an object has been modified, an "Updating" folder is displayed under the
name of this object. This folder contains specific details relating to the modification:

• The attribute that was modified
• The date of the change
• The user who made the change

Example of SolMan Updating Report with Updates

In the above example, the "Reclassify Product Master" and "Configure Classification
Help" transactions were altered in the project. They were made inactive.

This is indicated in the "Updating" folder. The value for the "SolMan ProcessStep Is
Active" attribute is set at "U" for inactive. When the attribute is set to "Active" the
value is "A".
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Using the schedule

Using the schedule in the SolMan Updating report allows you to:
• Attach a dispatch to your report. This shows everything that was done in 

the current transaction.
• Base the report generation on a specific time period. This allows you to 

see what was done during the specified time period.
 By default the report is based on what happened during the current 
transaction.

To set the schedule parameter for the updating reports:
1. From the SolMan project pop-up menu, select Report Discovery.
2. In the Available reports section, select SolMan Analysis.
3. Next to the report for which you want to set the calendar parameter 

select Customize and Launch a new report.

4. In the Properties dialog box of the report and in the Parameters tab, 
select the Schedule sub-tab.

5. In the Schedule section, click Connect and in the query dialog box that 
appears select the schedule desires and click OK.

6. In the list of results, select the desired schedule and click OK.
 You can also create your own calendar. See "Creating a schedule", 
page 69.

The Schedule appears in the Properties dialog box of the report.

Creating a schedule
 To create a schedule, you must first ensure that you at least have 
"Advanced" Metamodel Access rights to the repository you are using 
(Tools > Options).
 You can create schedules in HOPEX Windows Front-End only.

To create a schedule:
1. In the Utilities navigation window, right-click the Schedule folder and 

select New > Schedule.
2. Name your Schedule and click OK.

The new Schedule appears in the Utilities navigation window in the
Schedule folder.
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3. Open the Properties dialog box of the schedule and in the 
Characteristics tab indicate the Start date and if required, the End date 
of the schedule.

4. Click OK when finished.
Your schedule (calendar) is ready for use.

SolMan Updating Mapping Report

When you launch the SolMan Updating Mapping Report, two reports are available:
• Report Parameters
• SolMan Updating

Similarly to the SolMan Updating Report, the SolMan Updating Mapping report
presents the updates made to SolMan projects from a particular point in time in the
current HOPEX transaction. 

This report also displays the mapping relations in the SolMan project and the impact
of the different updates on the mappings between:

• HOPEX objects
• SolMan objects.

The mapped HOPEX objects appear in the tree in the list under the SolMan object
with which it is mapped.

Example of a SolMan Update Mapping Report without updates
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The SolMan project information is displayed in a tree.

Example of a SolMan Update Mapping Report with updates

As can be seen in the SolMan Updating Mapping report example above, changes and
updates are not displayed in an "Updating" folder. They are simply added to the
tree.

This report simply indicates the mapping updates/changes that have been made but
offers no details.

Solman Project Mapped Element Report

This report displays a list of business objects mapped totally or partially with a set
of objects originating from a SolMan project.

 You can use this report when intializing a SolMan structure from a 
BPMN diagram. For more information, see "Initializing a SolMan Project 
from Business Objects", page 39.
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Accessing the report

You can launch this report from a SolMan mapped element.
 For more information about how to generate the report, see 
"Report Generation", page 62.

Displayed attributes

For each object, the following properties are displayed:
• Object Name
• MetaClass
• REAL SAP: specifies whether the mapped SolMan element is a real SAP 

object. 
 This attribute can be edited. 

• Mapped: indicates whether a SolMan element is mapped to this object. 
The cell can be entered with:
• a check mark: the object is mapped with one SolMan element 
• no check mark: the object is NOT mapped with a SolMan element.
• "X": the object is mapped with several SolMan elements.

• Active: indicates if the mapped SolMan element is active in SAP Solution 
Manager. It refers to the "In scope" concept.

 This column is relevant only when the object is mapped with one 
SolMan element only.

• Global: corresponds to the Global attribute which indicates if in SAP 
Solution Manager this attribute is:
• local to the project
• global (defined and inherited from a more general project such as a 

template project). 
 This attribute is read-only.
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Solman Project Properties Report

This report displays the list of objects of a Solman project or part of a project.

Accessing the report

You can launch it from a:
• SolMan Project
• SolMan Solution
• SolMan Scenario
• SolMan Process

 For more information on how to generate the report, see "Report 
Generation", page 62.



74 HOPEX SAP Blueprint

3

Result

For each object, the following properties are displayed:
• the Name of the object with the corresponding icon
• the name of the MetaClass
• Active: indicates if the object is active or not in SAP Solution 

Manager. It refers to the "In scope" concept in SAP.
 This attribute can be edited.

• Mapped: indicates if a mapping exists for this object of the Solman 
project hierarchy.

 This attribute is read-only.

 For more information about mapping, see "Mapping SolMan Objects 
with Business Objects", page 35.

• Global: corresponds to the Global attribute which indicates if in SAP 
Solution Manager this attribute is:
• local to the project
• global (defined and inherited from a more general project such as a 

template project). 
 This attribute is read-only.

• Component: displays the name of a Solman component linked to:
• a Solman Transaction
• a Solman Process Step
• a Solman Master Data
• a Solman OrgUnit

Object Differences Report

This report gives a detailed view of the differences that exist between:
• the current object (the current object from which the report is displayed)
• its originating object (the varied object). 

It allows you to determine which elements have been added and/or deleted.
The report can indicate the differences between a 
ProcessStep (the current object) in an implementation 
project and its equivalent (the varied object) in a template 
project.

 This report serves as a basis for generation of the following global 
report: "Hierarchy Differences Report", page 75.
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Accessing the report

To access this report on object differences:
 In an object properties dialog box, click the SolMan Differences tab.

Result

The report comprises two parts:
• the varied object in relation to the current object.

 The current object is the one from which the report is displayed.

• a table recapitulating the objects which have been:
• added

 The added objects are the objects owned by the current object and 
which do not exist in the varied object.

• deleted
 The deleted objects are the objects owned by the varied object and 
which do not exist in the current object.

Hierarchy Differences Report

This report lists all the differences existing within a project or hierarchy. The
differences are listed object by object.

 It aggregates the results of the following report: "Object 
Differences Report", page 74.
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Accessing the report

you can launch this report from a:
• SolMan project
• SolMan scenario
• SolMan process

 For more information on how to generate reports, see "Report 
Generation", page 62.

Result

If you launch the report from a SolMan scenario, the following data is collected:
• First, data concerning this scenario.
• Second, data concerning all Solman processes, SolMan process steps 

and SolMan transactions.

The report is divided into several chapters:
• SolMan Project differences
• SolMan Solution differences
• SolMan Scenario differences
• SolMan MasterData differences
• Solman OrgUnit differences
• SolMan Process differences
• SolMan ProcessStep differences
• SolMan Transaction differences
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HOPEX SAP BLUEPRINT GLOSSARY 

The glossary presents the main concepts used in HOPEX SAP Blueprint. 

business process More often referred to as Processes in SAP Solution manager, these
objects are used to group Business steps.

business process step More often referred to as Process Step. In SAP Solution Manager,
this object is used to represent business activities.

business scenario More often referred to as Scenarios in SAP Solution Manager,
scenarios are used to group sets of business processes. They may
be used to represent types of models such as value chains,
functions and business domain object types.

implementation 
project

An implementation project is used to implement business
processes in an SAP landscape.

maintenance project A maintenance project is used to maintain changes in the
productive environment (solution).

master data Master data refers to data objects which contain control data that
are relatively constant over time. This data does not change very
often. Master Data may be assigned at the project-level as well as
at the scenario level. At the project level, they are used within the
scope of the entire project. At the scenario level, they are
responsible for the corresponding business scenario and all its
related business processes.

organizational unit In SAP Solution Manager, an Organizational Unit can refer to a
business object used to define the financial and logistic structures
within a specific SAP component.

process step A process step is an elementary activity performed to accomplish
a process.
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system landscape A system landscape is composed of an arbitrary number of
components which are referenced by process steps and
transactions.

template project A template project is used to create and distribute a template
defining the project structure.

transaction In SAP Solution Manger, a transaction is actually a dialog or a form
and can therefore be compared to a business transaction. For
Master Data and Organizational Units, transactions are used to
maintain the corresponding master data or organizational unit.
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INSTALLING THE MEGA / SOLMAN INTERFACE 

Although the MEGA / SolMan  interface is installed with HOPEX SAP Blueprint it requires installing 

additional components. 

Making MEGA/Solution Manager interface fully operational requires: 

• Unzipping installation files 

• Installing the transport order 

• Installing the SAP Java Connector 

• Installing additional shapes 

• Copying the HOPEX SAP Blueprint generation parameter file (if you need to generate SolMan 

objects from business objects as well as the associated report). 

Unzipping installation files 

The MEGA / SolMan CD contains the following files: 

• mega_solman interface installation.doc: This document. 

• transport_order_xxx.zip: Transport Order files to import to the SAP System. 

• patch_xxx.zip: An update to the Transport Order if necessary. 

• solman-shape.zip: Contains additional shapes for BPMN elements mapped to HOPEX SAP 

Blueprint objects. 

Installing the transport order 

The transport order (and its update if necessary) must be installed on the SAP server. 

Installing the SAP Java Connector 

To install the SAP Java connector component (SAP JCo): 

1. Download it from SAP web site with your SAP customer identifier. 
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2. Copy sapjco3.dll and sapjco3.jar files to the “java/lib directory” of MEGA installation path.  

Installing additional shapes 

Additional shapes are available for BPMN diagrams to identify objects mapped to a MEGA SolMan element. 

 

To install these shapes: 

1. Copy all .mgs files from “solman-shape.zip” to the  “Mega_Usr” folder. 

2. Import the .mgl file to the system database of your environment. 

Copying the generation parameter file 

The wizard for generating SolMan objects from business objects and the associated report  “SolMan Project 

Mapped Element report” require creation of a parameter file. 

For more information on the contents of the parameter file, see the HOPEX SAP Blueprint user guide, chapter “Designing for 

SAP Projects”, paragraph “Initializing a SolMan project from business objects”. 

 

This mapping file must be copied to the following folder: 

 

<Environment folder>\Db\<Repository Name>\USER\<User Name>\megasolmanbusinessimport.ini 
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Summary 
 

This tocument tescribes the system requirements ant teployment types for MEGA Solman. 
HOPEX SAP Blueprint has an interface with SAP Solution Manager. 

 
This tocument applies to 

• HOPEX V1R2 CP8.0 ant higher CPs. 
• HOPEX V1R3 CP8.0 ant higher CPs. 

 

It toes not tescribe: 
• How to perform installations (see installation tocumentation). 

• How to upgrate installations (see CP/SP upgrate tocumentation). 
• How to manage installations (see atministrator manuals). 

• How protucts are licenset (see licensing tocumentation). 
• How to use features (see user manuals). 
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DEPLOYMENT 

 
Here is a short tescription of the most common teployment motel, recommentet for stantart 

requirements. 
 

2 main notes are involvet: 

• -intows Client (HOPEX -intows Front-Ent). 
• SAP Server (SAP Solution Manager Server). 

 
 

Windows Client

MIK 

SAP Server

SAP Solu t ion

Manager

SAP Reference Model

JCo

Call (Java) Response (Java)

RFC Request RFC Response

 
 

 
Note that other components (SQL Server Native client, Flash player) can be requiret on the 

-intows client tepenting on the situation. See the article '-intows Front-ent Architecture 
Overview HOPEX V1R2-V1R3 EN'. 
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DEPLOYMENT REQUIREMENTS 

Windows client 

 

Client System (1) -intows 7.0 SP1 (32-bit or 64-bit) 

-intows 8 (32-bit or 64-bit) 
-intows 8.1 (32-bit or 64-bit) 

-intows Server 2008 R2 SP1  

-intows Server 2012 SP2 
-intows Server 2012 R2 

MEGA Version HOPEX V1R2-V1R3 (2) 

Hardware Processor 

multi-core 
RAM 

2 GB minimum 
4.0 GB or higher recommentet 

Resolution and colours 

16 M colors 
Screen resolution 

800 x 600 minimum 
1024 x 768 or better recommentet 

Disk space 
4 GB for MEGA Kernel 

JCo 3.x (version 3.0.9 ant higher)  

 

(1) System supportet by HOPEX V1R2-V1R3 -intows Front-Ent.  
(2) HOPEX V1R2-V1R3 installs ant runs a private JRE version 7 (32-bit). 

 
Verify that the iersion of JCo is compatible with: 

• The client system used. 
• The JRE used. 

 

SAP Serier 

 

SAP Version SAP Solution Manager version 7.1 

Transport orter built 900879 ant higher (3)  

 

(3) The version of transport orter may vary with the CP number. The appropriate version of 
transport orter is installet in the subfolter '\Utilities\Solman' of the HOPEX installation. See 

also compatibility table later in this tocument. 
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COMMUNICATION 

Between Windows Client and SAP Serier 

 

Protocol RFC protocol 

Port Refer to you SAP Atministrator (*) 

 

(*) See also this web page 
http://www.stn.sap.com/irj/scn/go/portal/prtroot/tocs/library/uuit/4e515a43-0e01-0010-

2ta1-9bcc452c280b?QuickLink=intex&overritelayout=true 
 

 

http://www.sdn.sap.com/irj/scn/go/portal/prtroot/docs/library/uuid/4e515a43-0e01-0010-2da1-9bcc452c280b?QuickLink=index&overridelayout=true
http://www.sdn.sap.com/irj/scn/go/portal/prtroot/docs/library/uuid/4e515a43-0e01-0010-2da1-9bcc452c280b?QuickLink=index&overridelayout=true
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GLOSSARY 

Term Definition 

Environment, MEGA environment A MEGA Environment is a working area, storing tata of a 

user group. -ithin a MEGA environment, a set of tata 
repositories share within a system tatabase a metamotel 

tefinition, users ant profiles. An environment is thus mate 

of a single system tatabase ant of one or multiple tata 
repositories. 

 

HOPEX SAP Blueprint HOPEX SAP Blueprint is a specific protuct supportet by 
MEGA ant is solt separately from SAP Solution Manager. It 

enables the import/export of tata into/from SAP Solution 
Manager ant the mapping of importet tata with MEGA 

Process BPMN tata. 

JCo SAP JCo (Java Connector) is a SAP component that enables 

to built interfaces between SAP software ant other tools 
The protuct HOPEX SAP Blueprint uses an interface with 

SAP Solution Manager. 
The technology of the interface varies with the version of 

MEGA: 
• MEGA 2009 SP5 CP9.0 ant lower: BPM-X 

technology is uset 
• HOPEX: JCo technology is uset 

MEGA License, license Licence uset to run MEGA Software (Protuct, Motule or 

Buntle). There are tifferent technologies available. The 

most common one is the MEGA Must licence. 

SAP Solution Manager Solution Manager is a SAP tool provitet with the 
Netweaver platform to tesign, implement, manage ant 

monitor SAP system implementation.  

SAP User Account for HOPEX SAP 
Blueprint 

SAP User account uset to exchange tata between HOPEX 
SAP Blueprint ant SAP Solution Manager. 

Transport Orter Package Installation package provitet by MEGA. It uses the 

Transport Program of the SAP system. 
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FAQS 

Can HOPEX SAP Blueprint run with Citrix? 

Yes. The -intows client can be a Citrix Server. 

Do I need to install C++ runtimes to run on Windows for JCo? 

No. These runtime components are alreaty installet with MEGA -intows Front-ent.  

How can I get JCo? 

MEGA toes not tistribute this component. Use a valit account on SAP Service Market Place to 

townloat it. See your SAP atministrator. 

What are the system requirements for SAP JCo? 

MEGA toes not tistribute this component. Use a valit account on SAP Service Market Place to 

townloat it. See your SAP atministrator 

How can I install JCo? 

Refer to ‘MEGA SolMan Interface Installation Guite HOPEX V1R2-V1R3’ in HOPEX SAP Blueprint 

user guite. 

How can I get the Transport order? 

The appropriate transport orter is installet in the subfolter '\Utilities\Solman' of the 
installation. 

Ex: C:\Program Files (x86)\MEGA\MEGA HOPEX V1R2\Utilities\Solman 

Compatibility table 

Depenting on the version of MEGA, certain versions of the client ant server layers are 

requiret. It may not be possible to use tifferent versions of MEGA with the same SAP Server. 
 

The appropriate transport orter is installet in the subfolter '\Utilities\Solman' of the 

installation. 
 

Version of MEGA Interface client 

layer 

Interface serier 

layer 

SAP Compatibility 

HOPEX V1R2 
HOPEX V1R2 CP1.0 

3.x (version 3.0.9 
ant higher) 

Transport orter built 
900478 

Compatible with SAP 
Solution Manager 7.1 

HOPEX V1R2 CP2.0 3.x (version 3.0.9 

ant higher) 

Transport orter built 

900605 

Compatible with SAP 

Solution Manager 7.1 

HOPEX V1R2 CP4.0 

 

3.x (version 3.0.9 

ant higher) 

Transport orter built 

900879 

Compatible with SAP 

Solution Manager 7.1 

HOPEX V1R2 CP8.0 
HOPEX V1R3 CP8.0 

3.x (version 3.0.9 
ant higher) 

Transport orter built 
900879 

Compatible with SAP 
Solution Manager 7.1 
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